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n	 objectives
Upon completion of this lesson, you should be able to:

n	 Create a table and insert text.

n	 Insert and delete rows and columns.

n	 Adjust column width and row height.

n	 Use the Draw Table and Eraser tools to create and edit a 
table grid.

n	 Format text alignment and direction within a table cell.

n	 Format borders and shading and apply table styles.

n	 Sort data in a table.

n	 Convert text to a table and vice versa.

n	 Data Files
To complete this lesson, you will need these data files:

Step10–13.docx

Project10–1.docx

Project10–2.docx

Lesson 10

Working with Tables

n	 vocabulary
ascending order

cell

descending order

gridlines

merging cells

Quick Tables

splitting cells
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Suppose you have a document in Word that includes information you want to 
arrange in several lines across two or three columns. How can you create the col-
umns you need in Word? If your answer is “Set tab stops,” you’re correct. However, 
there’s also an easier and faster way. The table features in Word make the task of 
arranging text and numbers in columns both quick and easy. Borders and shading 
also help to organize information in a meaningful way.

Creating a Table
A table consists of cells to which you add content, such as text, numbers, or graph-
ics. A cell represents one intersection of a row and a column in a table. In a table, 
rows go across and columns go down. It is common to add headings at the top of 
columns to label the content in the columns.

To create a table, you must first decide how many columns and rows you want 
in the table. You then create a table grid and enter the data.

To move the insertion point from one cell to another, you can press the arrow 
keys or Tab. When you reach the end of a row and press Tab, the insertion point 
moves to the first cell in the next row.

Step-by-Step 10.1
	 1.	 Open a new blank document. Click the Insert tab and then click the 

Table button in the Tables group shown in Figure 10–1. A grid of table 

cells appears.

Table button

	 2.	 Drag the mouse pointer down the grid until seven rows of cells are high-

lighted, then continue to drag the mouse pointer across until the top of 

the grid shows 3×7 Table, as shown in Figure 10–2. Click, and the table 

is inserted in the document.

Three columns
by seven rows

Live preview
of the table

2-2.1.13

◗  Vocabulary
cell

Figure 10–1 
The Tables group on the Insert tab

Figure 10–2 
The Insert Table grid with the 
number of columns and rows 
selected

Extra for Experts

You can also create a table by 
opening the Insert Table dialog 
box and entering the number of 
rows and columns. On the Insert 
tab, click the Table button and 
then click Insert Table to open the 
dialog box.
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	 3.	 Because the insertion point is now positioned in a table in the document, 

the Ribbon adapts and shows Table Tools, which are features you can use 

to format and edit tables. Compare your screen with Figure 10–3. There 

are two Table Tools tabs: the Design tab and the Layout tab.

There are two Table Tools tabs

	 4.	 The insertion point should be positioned in the first cell of the table. 

Press Tab to move the insertion point to the next cell to the right in the 

same row. Enter 20 Minutes. Press Tab and then enter 40 Minutes.

	 5.	 Press Tab to move the insertion point to the first cell in the next row.

	 6.	 Press the down arrow to move the insertion point down to the 

third row.

	 7.	 Enter the remaining data shown in Figure 10–4. Use Tab or the arrow 

keys to move from one cell to another.

	 8.	 Save the document as Calories1 and leave the document open.

Modifying the Table Structure
After you create a table, you may decide to change it. For example, you may need to add 
more rows or delete a column. Word has many features that make these changes easy.

Inserting Rows and Columns
To insert a new row at the end of the table, you can position the insertion point in 
the last table cell and press Tab. To insert a new row anywhere else in the table, or to 
insert new columns, you can use the insert commands on the Table Tools Layout tab. 

Step-by-Step 10.2
	 1.	 If necessary, open Calories1 from your solution files. Save the document 

Calories1 as Calories2. If necessary, click any cell in the table to show 

the Table Tools Design tab.

Figure 10–3 
The Table Tools 
Design tab

Heads up

If nonprinting characters appear 
in your document, small squares 
will show in the left corner of 
each table cell. These squares are 
called end-of-cell markers. They 
will move to the right as you enter 
text in the cell. End-of-cell mark-
ers do not print.

Figure 10–4 
Table content for Step-by-Step 10.1

2-2.1.14
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	 2.	 Position the insertion point in the last cell in the table at the lower right 

(144 ). Press Tab to create a new row. Enter the following information in 

the new row:

Golf: using a cart	 84	 168

	 3.	 Move the insertion point to any cell in the third row (Cross-country 

skiing ). Click the Table Tools Layout tab for more table tools, as shown 

in Figure 10–5.

Rows &
Columns
group

Delete Table button Insert Rows Above button

	 4.	 In the Rows & Columns group, click the Insert Rows Above button in the 

Rows & Columns group. A new row is entered above the row where the 

insertion point is positioned, and the table now has nine rows.

	 5.	 Drag across all the cells in the fourth and fifth rows (Cross-country 

and Downhill ) to select the cells. Click the Insert Rows Below button 

. Because you selected two rows, two new rows are inserted 

below the selection. Click anywhere in the document window to dese-

lect the cells.

	 6.	 Enter the following information in the sixth and seventh rows:

Walking: 15 minutes/mile	 108	 216

Running: 9 minutes/mile	 264	 528

	 7.	 Move the insertion point to any cell in the third column (40 Minutes). 

Click the Insert Columns to the Left button . A new column 

is added to the left side of the column where the insertion point is 

positioned.

	 8.	 Position the mouse pointer above the first row in the first column. When 

the mouse pointer changes to a down-pointing arrow , click to select 

the column. Click and drag the mouse pointer across to select both the 

first and the second column.

	 9.	 With the first two columns selected, click the Insert Columns to the 

Right button . Two new columns are added to the right side 

of the second column and the width of the columns is automatically 

adjusted. Notice the text automatically wraps to a new line within the 

cells of the first column.

	10.	 Click in the top cell of the new third column and enter 30 Minutes. 

Press the down arrow to move down to the fourth row and enter the fol-

lowing numbers to complete the column:

Figure 10–5 
The Table Tools  
Layout tab

Extra for Experts

You can use the number pad on 
your keyboard to enter numbers. 
Make sure that NUMLOCK is 
turned on.
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288

216

162

396

198

306

108

126

	11.	 Save the changes and leave the document open.

Deleting Rows and Columns
To remove rows or columns, you must choose the Delete commands on the Table 
Tools Layout tab. When you delete a row or column, the text in the cells is also 
deleted.

Step-by-Step 10.3
	 1.	 If necessary, open Calories2 from your solution files. Save the document 

Calories2 as Calories3. If necessary, show the Table Tools Layout tab.

	 2.	 Position the mouse pointer to the left side of the ninth row (Mountain 

biking). The pointer will change to a right-pointing arrow . With the 

arrow pointed at the first cell of the ninth row, click the mouse button to 

select the entire row.

	 3.	 With all the cells selected in the ninth row, press Delete. When you 

delete the text in a cell, the cell boundaries remain.

	 4.	 With the insertion point in the ninth row, click the Delete Table button  

in the Rows & Columns group, and then click Delete Rows. The row 

where the insertion point is positioned is deleted.

	 5.	 Select the ninth row (Weight lifting), click the Delete Table button, and 

click Delete Rows.

	 6.	 Select the two blank rows, click the Delete Table button, and then click 

Delete Rows.

	 7.	 Position the insertion point in the first cell in the first column (a blank 

cell). Click the Delete Table button and then click Delete Cells. The 

Delete Cells dialog box will open.

	 8.	 Click the second option Shift cells up and then click OK. The cell 

is deleted, and the contents of the cells below the deleted cell are 

shifted up.

	 9.	 Click the Undo button to restore the table cell and the data that was in it.

Heads up

You can also select table cells by 
clicking the Select Table button in 
the Table group on the Table Tools 
Layout tab.

Extra for Experts

You can also quickly access com-
mands to insert and delete cells, 
rows, and columns by right-clicking 
the selected cell or cells and then 
choosing a command from the 
shortcut menu. 
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	10.	 Select the two blank columns, click the Delete Table button, and then 

click Delete Columns.

	11.	 Save the changes and leave the document open.

Adjusting Column Width and Row Height
When you create a table grid, Word makes all the columns the same width, and the 
entire width of the table is based on the settings for the margins and paper size when 
the table is inserted. You can adjust the width of each column automatically using the 
AutoFit feature. You can choose to automatically adjust the column width as needed, 
to accommodate the contents within the cells, or you can choose to automatically 
resize the table to fit in the document window. This is useful because the table width 
automatically adjusts when the window size changes.

The height of each row is the same when the table is first inserted, but when 
the text wraps to a second line within a cell, the height of all the cells in that row is 
automatically increased to accommodate the extra line of text.

Step-by-Step 10.4
	 1.	 If necessary, open Calories3 from your solution files. Save the document 

Calories3 as Calories4. If necessary, switch to Print Layout view.

	 2.	 Click the View tab and click the Page Width button in the Zoom group.

	 3.	 Position the insertion point in the first cell in the table (a blank cell) 

and click the Table Tools Layout tab. In the Cell Size group, shown in 

Figure 10–6, note the height of the row that appears in the Table Row 

Height box.

Table Row
Height box

Table Column
Width box

	 4.	 Move the insertion point to the fourth row (Walking). Notice that the 

numbers in the Table Row Height box change to reflect the difference in 

the height of the row.

	 5.	 With the insertion point positioned in the first column, look at the 

width of the column that appears in the Table Column Width box. Click 

anywhere in the second and third columns. The numbers in the Table 

Column Width box may vary for each column.

	 6.	 With the insertion point positioned anywhere within the table, click the 

AutoFit button  in the Cell Size group and then click AutoFit 

Contents. The text in the first column no longer wraps within the cells, 

and the extra white space in the other three columns is eliminated.

Figure 10–6 
The Cell Size group on the Table 
Tools Layout tab

Heads up

When a table cell is formatted for 
AutoFit Contents, Word will auto-
matically adjust the cell width each 
time the cell contents change.
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	 7.	 With the insertion point positioned anywhere within the table, click the 

AutoFit button again and then click AutoFit Window. Extra space is 

added to the columns so that the table fills the width of the page.

	 8.	 Click the Page Layout tab, click the Page Orientation button, and then 

click Landscape. The width of each column adjusts so the table fills all 

the space between the left and right margins.

	 9.	 Click the Page Orientation button and then click Portrait to return to the 

original page orientation.

	10.	 Click the Undo button arrow and then click AutoFit Window. This will 

restore the setting so that the columns are adjusted to fit the contents.

	11.	 Click the Table Tools Layout tab and in the Table group, click the Select 

Table button  and then click Select Table.

	12.	 Click the up arrow in the Table Row Height box to increase the row 

height to 0.3". 

	13.	 Deselect the table rows. Save the changes and leave the document open.

Merging and Splitting Table Cells
When you remove the boundary between two cells, it is called merging cells. You 
can merge cells horizontally or vertically. You can merge cells when you want to cre-
ate a heading to span across two or more columns.

When you convert a cell into multiple cells, it is called splitting cells. You can 
split a cell into two or more rows and/or two or more columns. You can also split a 
table into two separate tables.

Step-by-Step 10.5
	 1.	 If necessary, open Calories4 from your solution files. Save the docu-

ment Calories4 as Calories5. Also, if necessary, click in the table and 

then click the Table Tools Layout tab.

	 2.	 With the insertion point positioned anywhere within the table, click the 

AutoFit button in the Cell Size group and then click AutoFit Window.

	 3.	 Position the insertion point in the first row in the table and then click 

the Insert Rows Above button. A new row is added and the four cells in 

the new row are selected.

◗  Vocabulary
merging cells

splitting cells
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	 4.	 With all the cells in the new row still selected, click the Merge Cells button 

 in the Merge group, shown in Figure 10–7. Click in the table 

to deselect the row. The four cells have merged into a single, wide cell.

Merge group

	 5.	 Position the insertion point in the new blank row and then click the 

Split Cells button . The Split Cells dialog box will appear.

	 6.	 Change the number in the Number of columns box to 1. Change the 

number in the Number of rows box to 2. Click OK. Click anywhere in the 

table to deselect the row. You will see that the row is split into two rows.

	 7.	 Position the insertion point in the top blank row and enter NUMBER OF 

CALORIES BURNED. Press Enter and then enter Body weight: 150 lbs. 

The height of the cells is automatically adjusted to accommodate the 

two lines of text.

	 8.	 Click in the second row of the table and click the Split Cells button. 

Click OK to accept the proposed settings of two columns and one row. 

The row will be split evenly into two cells.

	 9.	 Position the mouse pointer over the border that splits the row into two 

cells. When the pointer changes to a double-headed arrow, drag the bor-

der to the left so that it aligns with the first column border, as shown in 

Figure 10–8.

Original
border
position

New border
position

	10.	 Click in the cell directly below Body weight and enter Activity. Click in the 

cell directly above the 20 Minutes column and enter Length of Time.

	11.	 Position the insertion point anywhere in the seventh row (Running), and 

then click the Split Table button . The rows now appear in two 

separate tables.

Figure 10–7 
The Merge group on the Table Tools 
Layout tab

Figure 10–8 
Drag a cell border to resize the cell
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	12.	 Click the Undo button to return the two tables to one table.

	13.	 Save the changes and close the document.

Drawing a Table
There may be occasions when you need to create and customize a more complex 
table. For example, the table may require cells of different heights or a varying num-
ber of columns per row. The Draw Table tool is very useful for creating complex 
tables. When you use the Draw Table tool, you use the mouse to draw the table grid 
on the screen the same way you would use a pen to draw the grid on a sheet of paper. 
The document must be displayed in Print Layout view.

The Eraser tool enables you to remove cell boundaries. Click the Eraser button, 
and the pointer changes to an eraser. When you point and click a cell boundary, the 
line will be selected. When you release, the boundary is deleted.

Step-by-Step 10.6
	 1.	 Open a new blank document. Click the View tab, make sure the Ruler is 

checked, and then click the Page Width button.

	 2.	 Click the Insert tab. Click the Table button and then, in the menu below 

the grid, click Draw Table. The mouse pointer changes to a pencil.

	 3.	 Position the mouse pointer in the upper-left corner of the document 

near the flashing insertion point. Notice that as you move the mouse 

pointer, the position of the pointer is indicated on both the horizontal 

and vertical rulers.

	 4.	 To draw the outside boundary of the table grid, position the pointer in 

the upper-left margin. Then click and drag the pencil down and to the 

right. As you drag the mouse, markers on the vertical and horizontal rul-

ers will show the table size, as shown in Figure 10–9. Release when the 

table (box) is approximately 6 ½ inches wide by 2 ½ inches high.

Markers
on rulers
indicate
table size

2-2.1.3
2-2.1.13

Extra for Experts

You can also use the Draw Table 
tool and the Eraser tool to add, 
delete, split, and merge cells in an 
existing table.

Figure 10–9
Creating the outside 
boundary of a table grid
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	 5.	 To create the cell lines inside the table, position the point of the pen-

cil where you want the line to begin and then click and drag to the 

point where you want the line to end. A broken line will display as you 

drag the mouse. Draw all of the lines illustrated in Figure 10–10. Note 

that the four horizontal lines are ½ inch apart and the three vertical 

lines are positioned at 1 inch, 4 ½ inches, and 5 ½ inches on the hori-

zontal ruler.

Marks on
rulers
indicate
position of
boundaries

Draw Table
button
toggled on

Table Eraser
button

	 6.	 On the Table Tools Design tab in the Draw Borders group, click the Draw 

Table button to toggle off the Draw Table option.

	 7.	 Click the Table Eraser button. The pointer changes to an eraser.

	 8.	 Position the eraser in the first row on the vertical line between the first 

and second cells. When the lower corner of the eraser is positioned over 

the line and you hold down the mouse button, the line appears selected 

as it does in Figure 10–11.

Also remove
these lines
in this
column

Eraser tool

	 9.	 Release the mouse button to delete the selected boundary. If you click 

and the line is not deleted, reposition the eraser and try again. The line 

will only be deleted if it is selected when you click.

Figure 10–10
Table grid for  
Step-by-Step 10.6

Heads up

You can also press Escape to toggle 
off the Draw Table option.

Figure 10–11
Eraser tool with 
selected line
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	10.	 Erase two more lines in the first column as indicated in Figure 10–11.

	11.	 Click the Table Eraser button to toggle the feature off.

	12.	 Enter the table text shown in Figure 10–12.

	13.	 Save the document as Recycling Rate1 and leave the document open.

Formatting Tables
You can make a table easier to read by enhancing its appearance. For example, align-
ing numbers within a cell can make the data easier to read. Changing the border 
colors and adding shading to some of the cells can help the reader quickly identify 
different types of data.

Aligning Data within Table Cells
The Alignment group in the Table Tools Layout tab includes several buttons you can 
use to align text within the cells. You can align text at the top, center, or bottom of a 
cell, as well as to the left or right. You can also change the direction of text in a table 
cell. The direction of the text toggles between three text positions: top to bottom, 
bottom to top, and horizontal (the default position).

Step-by-Step 10.7
	 1.	 If necessary, open Recycling Rate1 from your solutions files. Save the 

document Recycling Rate1 as Recycling Rate2. Click the Table Tools 

Layout tab.

	 2.	 Drag the mouse pointer down the left side of the table to select all the 

rows in the table.

	 3.	 Click the Table Row Height box and enter 0.5. All the rows are now 

exactly the same height.

Figure 10–12
Table content for Step-by-Step 10.6

2-2.1.13
2-2.1.14
2-2.1.15
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	 4.	 In the Alignment group, click the Align Top Right button  shown in 

Figure 10–13. The text in each cell is aligned at the right side of the 

cell beginning at the top boundary of the cell.

Align
Center
button

Align Top
Right button

	 5.	 Click the Align Center Left button . The text begins at the left side of the 

cells and is centered between the top and bottom boundaries of the cell.

	 6.	 Deselect the rows. Point to the cell with PET and drag down to select 

that cell and the cell with HDPE.

	 7.	 With both cells selected, click the Text Direction  button in the 

Alignment group. The text rotates to the right and is shown from top 

to bottom.

	 8.	 Click the Text Direction button again. The text rotates to the right and 

now reads from bottom to top.

	 9.	 Notice that the buttons in the Alignment group are altered to reflect 

the new text direction. Click the Align Center button  in the location 

shown in Figure 10–13. The text is centered between the left and right 

and top and bottom boundaries of the cell.

	10.	 Click in the first cell (Recycling Rate) and then click the Align 

Center button.

	11.	 Select the last two columns (2000 and 2010) and then click the Align 

Center Right button . The text in each cell is aligned at the right side 

of the cell and centered between the top and bottom boundaries.

	12.	 Deselect the cells. With the insertion point positioned anywhere within 

the table, click the AutoFit button, and then click AutoFit Contents. 

Your table should look like the table shown in Figure 10–14.

	13.	 Save the changes and leave the document open.

Figure 10–13
The Alignment group on the Table 
Tools Layout tab

Figure 10–14
Table with text rotated and aligned
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Formatting Borders and Shading
As you worked with the Calories and Recycle Rate tables you created in this lesson, 
the lines you saw on the screen were actually borders. By default, Word formats a 
½ point single-line border around all cells in a table. Generally, the default border 
will be appropriate for the tables you create. However, there may be occasions when 
you want to customize the border and add shading or color to some of the table cells. 
You may even want to remove the border completely. When you remove the borders 
from table cells, the boundary lines for the cells still remain. These boundary lines in 
a table are called gridlines. Gridlines are used for layout purposes; they show on the 
screen, but they do not print.

Step-by-Step 10.8
	 1.	 If necessary, open Recycling Rate2 from your solution files. Save the 

document Recycling Rate2 as Recycling Rate3.

	 2.	 Select all the cells in the table.

	 3.	 Click the Table Tools Design tab. In the Table Styles group, click the 

Bottom Border button arrow  and then click No Border.

	 4.	 Click in the table to deselect it. Your document should now show lines 

that indicate the cell boundaries, as shown in Figure 10–15. If you don’t 

see any broken blue lines in your table, click the Table Tools Layout tab 

and click the View Table Gridlines button .

Gridline

Pen color
options

Line weight
options

	 5.	 Select the first row in the table. On the Table Tools Design tab in the 

Table Styles group, click the Shading button arrow . Select a 

light green color. The shading is applied to the selected cells.

	 6.	 Select the cells containing PET and HDPE. Repeat the shading color 

format. (Hint: Press F4.)

◗  Vocabulary
gridlines

Figure 10–15
Table gridlines
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	 7.	 Select all the cells in the table. In the Draw Borders group, click the 

Line Weight list arrow, and then click ¾ pt. You must change the line 

weight setting before applying the border.

	 8.	 Click the Pen Color button arrow  and select a dark green color. 

You must also choose the border color before applying the border.

	 9.	 Click the Borders button arrow and then click All Borders. The ¾ pt 

dark green border line is applied to all selected cells.

	10.	 Click in the table to deselect the cells. Select all the cells in the first row.

	11.	 Click the Line Weight list arrow and then click 1 ½ pt.

	12.	 Position the mouse pointer over the Borders button. The ScreenTip should 

show All Borders because that was the last border format applied. The 

pen color is also still set for dark green. Click the Borders button. The 

1 ½ pt dark green border is applied to all borders of the selected cells.

	13.	 Select the cells containing PET and HDPE. Repeat the border format.

	14.	 Click in the table to deselect the table cells. Save the changes and close 

the document.

Applying Table Styles
As you can see, formatting borders and shading can take time. That’s why Word 
provides several table designs that you can apply with a single click. These styles are 
referred to as built-in styles.

Step-by-Step 10.9
	 1.	 Open Calories5 from your solution files and save the document Calories5 

as Calories6.

	 2.	 Select the first two rows, and in the Paragraph group, click the Center 

button.

	 3.	 With the insertion point positioned anywhere in the table, click the 

Table Tools Layout tab, click the AutoFit button, and then click AutoFit 

Contents.

	 4.	 Select all the cells that contain numbers (excluding the column head-

ings), beginning with the calories data 192 through the calories data 168, 

and then click the Align Top Right button in the Alignment group.
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	 5.	 Click the Table Tools Design tab. In the Table Styles group, position the 

mouse pointer over the second style, Light Shading. A live preview of 

the new style will appear in the document window and the ScreenTip 

will show the name Light Shading, as shown in Figure 10–16.

Click the
More button
to see all
styles

Click the
down arrow
to scroll
through
styles

Live preview

	 6.	 Move the mouse pointer over each of the other styles that appear in the 

Table Styles group to see a live preview of each style. Click the down 

arrow to see the next set of styles.

	 7.	 Click the More button to show all the built-in styles. 

	 8.	 Click the Light List – Accent 2 table style. The borders and shading are 

automatically applied to the table.

	 9.	 Select the column headings Length of Time, 20 Minutes, 30 Minutes, 

and 40 Minutes, and apply the bold format. (Hint: Click the Bold button 

on the Mini toolbar, or press and hold Ctrl and then press B.)

	10.	 Save the changes and close the document.

Using Quick Tables
Word also provides built-in tables, called Quick Tables, which include sample data 
and table formats. You can insert a Quick Table in a document and then replace the 
sample data with your own data, and you can modify the table structure and styles. 
Editing text in the cells of a table is a similar process to entering text in a document. 
You can enter and delete text, or select and replace the text. The Cut, Copy, and Paste 
commands are available, and you can also use drag-and-drop editing.

Figure 10–16
Live preview of 
a table style

◗  Vocabulary
Quick Tables
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Step-by-Step 10.10
	 1.	 Open a new blank document.

	 2.	 Click the Insert tab. Click the Table button and then, in the menu below 

the grid, point to Quick Tables. The submenu shown in Figure 10–17 

appears.

Scroll bar

	 3.	 Scroll down and click the Matrix Quick Table. A table with sample data 

is inserted in the document.

	 4.	 Select all the rows in the table. Press Delete to remove all the text from 

the cells.

	 5.	 Click the Table Tools Layout tab and select the two columns at the right 

side of the table. In the Rows & Columns group, click the Delete Table 

button and then click Delete Columns.

	 6.	 Enter the data shown in Figure 10–18 to complete the table. You will 

need to add two new rows at the bottom of the table grid.

Figure 10–17
The Built-In menu for  
Quick Tables
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	 7.	 Select all the rows in the table, click the Home tab, and then change 

the font to Arial.

	 8.	 Click the Table Tools Layout tab. Select the first column and then click the 

Align Bottom Left button  in the Alignment group. Select the second, 

third, and fourth columns and click the Align Bottom Center  button.

	 9.	 Save the document as Members1 and leave the document open.

Aligning and Resizing Tables on the Document Page
In this lesson, you have been selecting all the cells in a table, but you may not have 
actually selected the entire table. When you show nonprinting characters, you can 
see that every row ends with a marker. These end-of-row symbols must be included 
in the selection for the entire table to be selected.

To align a table on the page horizontally, you must first select the entire table. 
Once the entire table is selected, you can format the alignment in the same way you 
align text paragraphs.

You may have noticed a marker that sometimes appears at the upper-left corner 
of a table. This symbol is the table move handle, and you can drag the marker to 
reposition the table on the page. You can also use the table move handle to select the 
entire table.

The resize handle is another marker that sometimes appears in the lower-right 
corner of a table, and when you drag this symbol, you can resize the table.

Step-by-Step 10.11
	 1.	 If necessary, open Members1 from your solution files. Save the docu-

ment Members1 document as Members2.

	 2.	 If necessary, click the Home tab and then click the Show/Hide ¶ button 

in the Paragraph group to show nonprinting characters.

	 3.	 Position the insertion point anywhere within the table, and click the 

Table Tools Layout tab.

Figure 10–18
Table content for Step-by-
Step 10.10
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	 4.	 Click and drag the table move handle, shown in Figure 10–19, to repo-

sition the table on the page. If you do not see the table move handle, 

move the mouse pointer around the upper-left corner of the table until 

it appears.

End of cell
marker

Table
move
handle

Resize handle

End of row
marker

	 5.	 Click the table move handle to select the entire table. Notice that the 

end-of-row markers are also selected.

	 6.	 Click the Home tab. Click the Center button in the Paragraph group. 

The table is centered horizontally.

	 7.	 Point to the lower-right corner of the table. When the resize handle 

appears, position the mouse pointer over the handle. The pointer will 

change to a double-headed arrow. Drag the handle about one inch to the 

right to increase the width of the table.

	 8.	 Save the changes and leave the document open.

Sorting Data in a Table
Tables organize material to make it easier to read, and you have discovered how 
formatting the table and the characters in the table can add clarity to the information. 
You can also sort the information in a table on different search criteria to organize 
the table contents to emphasize data in different ways.

Sorting data in ascending order rearranges it into alphabetical order from A 
to Z, or numerical order from lowest number to highest number. Sorting data in 
descending order rearranges the data in alphabetical order from Z to A, or numerical 
order from highest number to lowest number.

Step-by-Step 10.12
	 1.	 If necessary, open Members2 from your solution files. Save the docu-

ment Members2 as Members3.

	 2.	 Position the insertion point anywhere in the table, and click the Table 

Tools Layout tab.

Figure 10–19
Nonprinting characters  
in a table

2-2.1.15

◗  Vocabulary
ascending order

descending order
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	 3.	 Click the Sort button in the Data group, shown in Figure 10–20, to open 

the Sort dialog box.

	
Data group

Sort button

	 4.	 Confirm that the Sort dialog box looks like the Sort dialog box in 

Figure 10–21, to sort by Member Name. The type of content to be 

sorted is Text.

Sort by box

Ascending option

	 5.	 To sort the data in descending alphabetical order according to the 

entries in the Member Name column, click the Descending option.

	 6.	 Click OK. The entries in first column of the table now appear sorted in 

reverse alphabetical order. Notice that the other columns in the rows 

were rearranged so that the correct entries for each row are in the sec-

ond, third, and fourth columns also.

	 7.	 Click the Sort button again. In the Sort by text box, click the list arrow and 

then click Member #. Notice that the Type text box changes to Number.

	 8.	 Click the Ascending option, and then click OK. The table is now arranged 

so that the numbers in the third column are in order from lowest to 

highest, and the other columns in the rows were rearranged also to keep 

the entries in rows together.

	 9.	 Save the changes and close the document.

Converting Text to a Table and a Table to Text
Assume that you’ve already created a multicolumn list using tab settings. You decide 
that you want to organize the data in a table because it will be easier to format. In 
Word, it isn’t necessary to enter all the data again. Word can quickly convert text sepa-
rated by paragraph markers, commas, tabs, or other characters into a table with cells.

Figure 10–20
The Data group on the Table Tools 
Layout tab

Figure 10–21
The Sort dialog box

2-2.1.13
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When converting text to a table, Word determines the number of columns needed 
based on paragraph markers, tabs, or commas in the text. When converting a table 
to text, Word inserts paragraph markers, tabs, or commas to show where the column 
breaks are.

Step-by-Step 10.13
	 1.	 Open Step10–13 from your data files. Save the document as Scores1.

	 2.	 Select all the lines of text.

	 3.	 Click the Insert tab. Click the Table button and then click Convert Text 

to Table. The Convert Text to Table dialog box opens.

	 4.	 Under Table size, the number of columns should already be set to 3. 

Under AutoFit behavior, select AutoFit to contents. Under Separate text 

at, make sure Tabs is selected.

	 5.	 Click OK. Click anywhere in the window to deselect so you can see the 

revised content. The selected data is now formatted in table cells.

	 6.	 Save the changes to the document, and then save the document as 

Scores2.

	 7.	 With the insertion point positioned anywhere within the table, click the 

table move handle to select the entire table.

	 8.	 Click the Table Tools Layout tab. In the Data group, click the Convert 

to Text button . The Convert Table to Text dialog 

box opens.

	 9.	 Replace the hyphen in the Other box with an asterisk (*) and click OK. 

The columns of text are now separated with an asterisk instead of a tab 

character.

	10.	 Deselect the text. Save the changes and then close the document.

Net Business

Internet Fraud
Internet fraud refers to any type of scam or hoax that uses one or more components of the Internet, such as 
e-mail, blogs, or Web sites. The most common types of Internet fraud are auction and retail schemes, busi-
ness opportunities and work-at-home schemes, identity theft, investment schemes, and credit/debit card 
fraud. Internet fraud is a federal crime. If you think you’ve been the victim of Internet fraud, you can file a 
complaint online at the FBI Web site, www.fbi.gov.

White collar crime refers to a full range of frauds committed by business and government professionals, 
and Internet fraud is one of the white-collar crimes that the FBI investigates. The Internet Crime Complaint 
Center (or IC3) is a partnership of the FBI and the National White Collar Crime Center.
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SUMMARY

In this lesson, you learned:

n	 The table feature in Word enables you to organize and arrange 
text and numbers easily.

n	 To change the layout of information after you create a table, 
you can insert and delete rows and columns.

n	 The AutoFit feature automatically adjusts the width of a col-
umn based on the contents of the cells in a column.

n	 The Draw Table tool and the Eraser tool are especially useful 
when you need to create a complex table.

n	 You can format text alignment in table cells the same way you 
apply those formats in other Word documents.

n	 Borders and shading greatly enhance the appearance of a table 
and often make the table easier to read.

n	 Word provides several built-in styles to make it fast and easy to 
apply borders and shading to a table.

n	 Word provides Quick Tables that are already formatted and 
contain sample data, so you can quickly create a table.

n	 You can use the Sort feature to reorganize the table contents to 
emphasize data in different ways.

n	 Word can convert text to a table or vice versa.

 Review  Questions

true / false
Circle T if the statement is true or F if the statement is false.

T	 F	 1.	 Table rows go down a page, and columns go across a page.

T	 F	 2.	 You cannot hide the gridlines in a table.

T	 F	 3.	 When you remove the boundary between two cells, you are splitting the cells.

T	 F	 4.	 When you delete a row or column, the text in the cells is also deleted.

T	 F	 5.	 Word can create a table from text in which data is separated by paragraph markers, tabs, or commas.

Multiple Choice
Select the best response for the following statements.

	 1.	 If you have already entered the data in a table, you can quickly add pre-designed borders and shading by .

A.	 using the AutoFormat feature	 C.	 applying a table style

B.	 using Quick Table formats	 D.	 using the Table Design command

	 2.	 The  option adds extra space to table columns so that the table fills the width of the page.

A.	 AutoFit Contents	 C.	 AutoSize Window

B.	 AutoFit Window	 D.	 AutoWidth Column

  Vocabulary Review
Define the following terms:

ascending order
cell
descending order

gridlines
merging cells

Quick Tables
splitting cells
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	 3.	 When using the mouse to draw the table grid on the screen, the document must be .

A.	 in Print Layout view	 C.	 at the zoom setting of 100%

B.	 in Draft view	 D.	 in Print Preview

	 4.	 Use the  tool to remove cell boundaries.

A.	 Remove Border	 C.	  Eraser

B.	 Table	 D.	 Cell Margins

	 5.	 Converting one cell into multiple cells is called  cells.

A.	 merging	 C.	 grouping

B.	 combining	 D.	 splitting

Fill in the Blank
Complete the following sentences by writing the correct word or words in the blanks provided.

	 1.	 To insert a new table, you click the  tab on the Ribbon.

	 2.	 Built-in tables called  include sample data and table formats.

	 3.	 To create a complex table, use the  tool to position cell boundaries just where you want them.

	 4.	 Sorting text in  order arranges it in alphabetical order from A to Z.

	 5.	  are nonprinting cell boundaries.

  Projects

Project 10–1
	 1.	 Open Project10–1 from the data files. Save the document as 

Population.

	 2.	 Position the insertion point at the end of the document and cre-
ate a grid for a 3×6 table (3 columns and 6 rows).

	 3.	 Complete the table by entering the data shown in Figure 10–22.

Figure 10–22  Table content for Project 10–1

	 4.	 You realize you left out the data for the 35–44 age group. 
Insert a row in the proper location and enter the following data: 
35–44  23,864  25,890

	 5.	 It would be helpful to see the percent change in population. 
Add a column to the right of the 2010 column and enter the 

column heading % Change in the first row. Insert the follow-
ing information in the cells of the new column:
–6.2
–16.0
+8.5
+48.6
+19.0
+16.0

	 6.	 Insert a new row above the first row of the table and merge all 
cells in it. Enter the table title Population by Age. Center and 
bold the contents in the first two rows of the table.

	 7.	 Automatically adjust the column widths to the content.

	 8.	 Center the table horizontally on the page.

	 9.	 The data in the % Change column would look better if the dec-
imal points were aligned. Right-align the numbers (but not the 
column heading) in this column.

	10.	 Shade alternate rows of the data beginning with the 18–24 row.

	11.	 Save the changes and close the document.
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Project 10–2
	 1.	 Open Project10–2 from the data files. Save the document as 

Hurricane History.

	 2.	 Select only the tabbed data (not the blank line or the source 
line) and convert the text to a table. Accept the suggested num-
ber of columns, select AutoFit to contents, and separate the 
text at tabs.

	 3.	 Insert a new row at the top of the table and merge all cells in 
it. Enter the title Costliest U.S. Hurricanes, press Enter, and 
then enter ($ in Billions).

	 4.	 Center the text in the new heading you just entered in the 
first row.

	 5.	 Center the data in the Category column, and right-align the 
data in the Damage column.

	 6.	 The data for Hurricane Andrew is wrong. Change the year for 
Andrew to 1992.

	 7.	 The data in the table is currently arranged in ascending order 
according to the Year column. Select all the cells with num-
bers in the Damage column and sort the data for Column 4 
so that the storms are listed in order, with the most expensive 
storm first.

	 8.	 You decide the first ten entries in the table give enough infor-
mation about the destructive power of hurricanes. Delete the 
last five rows in the table.

	 9.	 Apply a table style that will enhance the table and make it eas-
ier to read. If necessary, modify the table style to emphasize all 
the column headings.

	10.	 Save the changes and close the document.

Project 10–3
	 1.	 Open a new blank document and save the document as 

Order Form.

	 2.	 Use the Draw Table tool (and the Eraser tool, if necessary) to 
create the table shown in Figure 10–23.

Figure 10–23  Table grid and content for 
Project 10–3

	 3.	 After completing the grid and entering the text, automatically 
format the table to fit the window.

	 4.	 Select all the cells in the first column, set the text direction as 
shown, and center all the text vertically and horizontally using 
the Align Center option. Select all remaining cells and center 
all text vertically in the table cells using the Align Center Left 
option.

	 5.	 Select the entire table and set the row height at 0.6 inches.

	 6.	 Enhance the appearance of the table by adding or remov-
ing borders, adding shading, and formatting text, using bold  
and/or italic.

	 7.	 Save the changes and close the document.
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  Critical Thinking

Activity 10–1

  online discovery

Project 10–4

The owner of the stable where you ride horses has been com-
plaining about the comings and goings of her part-time staff and 
unpaid helpers (of whom you are one). She’d like a way to keep 
track of names, phone numbers, what days and hours each helper 

is scheduled, and hourly pay (if any). Use what you have learned in 
this lesson to create a table that will help the stable owner organize 
the information about her staff. Enter several fictitious entries in the 
table (including yourself) to test your solution.

In this lesson, you learned to use tables to organize data in Word. 
Did you realize that tables are also used to organize Web page con-
tent? Open several different Web pages and identify the table grid 
used for organizing the content on each page. Be sure to include 
all Web page elements, such as the Web page title at the top and 

the menu of links which often appear at the left. You will see that 
sometimes table border lines are used to enhance the appearance of 
the page, but in many cases, the table structure is not obvious in the 
Web page design. (Hint: Sometimes selecting all the content on the 
Web page will help identify the table structure.)

Figure 10–24  Table grid and content for Project 10–4

  Teamwork Project
If you completed Project 10–2, you learned how costly hurri-
canes can be in terms of property damage. The data shown in the 
Hurricane History table was compiled by the National Oceanic and 
Atmospheric Administration and is current only through 2006. You 
have probably heard about several powerful and costly Atlantic hur-
ricanes in the United States. With a partner, see if you can update 
the table with more recent data.

	 1.	 Write down the years from 2006 to the last complete hurri-
cane season (hurricane season begins in June and ends in 
November, so if you are working on this project before the end 
of November, do not include the current year in your list).

	 2.	 Split the years with your partner so that you each have half of 
them to research.

	 3.	 Using Web search tools or other research tools, try to locate a 
summary of hurricane damage for each year.

	 4.	 If any of the years you research total more dollar damage than 
the hurricanes shown in the Hurricanes table, insert new rows 
to add the data you have found.

	 5.	 When you have compiled the data, experiment with sorting the 
rows using different criteria and applying different formats to 
the column heads, borders, cells, and text.

	 6.	 With your partner, decide which format presents the data the 
way you prefer, and then add your names and the current date 
to the bottom of the document page.

	 1.	 Open a new blank document and save the document as 
Agenda.

	 2.	 Insert the Matrix Quick Table.

	 3.	 Edit the columns and rows and replace the sample data to cre-
ate a table that matches the table shown in Figure 10–24.

	 4.	 Align the text in all cells, except the headings, using the Align 
Center Left format.

	 5.	 Select all the cells and change the font to Arial. Select the col-
umn headings and apply the bold format.

	 6.	 Save the changes and close the document.
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